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Intfroduction

If youre new to Microsoft Word, you'll need to learn
the basics of typing, editing, and organizing text.
Basic tasks include the ability to add, delete, and
move fext in your document, as well as how 1o cut,
copy, and paste.




Using the inserfion point

The insertion point is the blinking vertical line in your
document. It indicates where you can enter text on

the page. You can use the insertion point in a variety
of ways.




Using the inserfion point

Blank document: When a new blank document opens,
the inserfion point will appear in the top-left corner of the
page. If you want, you can begin typing from this
location.
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Using the inserfion point

Adding spaces: Press the
spacebar to add spaces after a
word or in between text.
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New/paragraph line: Press Enter
on AJour keyboard to move the
insertfion point to the next
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Using the inserfion point

=» Manual placement. Once you begin

typing, you can use the mouse to
move the insertion point to a specific
place in your document. Simply click
the location in the text where you
want to place it.

Arrow keys. You can also use the
arrow keys on your keyboard fo
move the insertion point. The left and
right arrow keys will move between
adjacent characters on the same
line, while the up and down arrows
will move between paragraph lines.
You can also press Cirl+Left or
Ctrl+Right to quickly move between
entire words.



Selecting text

Before you can move or format text, you'll need to select it. To
do this, click and drag your mouse over the text, then release
the mouse. A highlighted box will appear over the selected text.

B H:0fignature Wash
Cars 520 - SUVs 525 and up

Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs. :
Interior vacuum, dust, and deodorize, plus windows inside & out.

When/you select text or images in Word, a hover toolbar with
CO and shortcuts will appear. If the toolbar does not appear
aft first, tfry hovering the mouse over the selection.
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B H:Ofignature Wash

Cars 520 - SUVs 5§25 and up

Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs. |
Interior vacuum, dust, and deodorize, plus windows inside & out.




Selecting mulfiple lines of text

I. Move the mouse pointer to the left of any line so it
becomes a right slanted arrow.

B H.0 signature Wash

Cars 520 - SUVs 525 and up

Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs.
Interior vacuum, dust, and deodorize, plus windows inside & out.

B signature Interior

Cars 540 - SUVs 560 and up - March special! 85 off

Shampoo carpets, floor mats, seats, and door panels. Clean and protect console, dash,
and cup holders.

D. Cli¢k the mouse. The line will be selected.

- H,0 Signature Wash
Cars 520 - SUVs 525 and up

" Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs.
Interior vacuum, dust, and deodorize, plus windows inside & out.

B signature Interior

Cars 540 - SUVs 560 and up - March special! $5 off

Shampoo carpets, floor mats, seats, and door panels. Clean and protect console, dash,
and cup holders.




[P Selecting multiple lines of text

To select multiple lines, click and drag the mouse up or down.

B H.0 Signature Wash

Cars 520 - SUVs 525 and up

Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs.
Interior vacuum, dust, and deodorize, plus windows inside & out.

B signature Interior
Cars 540 - SUVs 560 and up - March special! S5 off

Shampoo carpets, floor mats, seats, and door panels. Clean and protect console, dash,
£ and cup holders.

4. ' To select all of the text in your document, choose the Select
command on the Home tab, then click Select All. Alternatively,
y@u can press Cirl+A on your keyboard.
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Deleting a text

There are several ways 1o delete—or remove—text:

To delete text to the left of the insertion point, press the
Backspace key on your keyboard.

» [0 delete text to the right of the inserfion point, press the
Delete key on your keyboard.

» Select /the text you want to remove, then press the
Deleié key.



Copying and moving ftext

Word allows you to copy text that's already in your
document and paste it in other places, which can
save you a lot of time and effort. If you want to move
text around Iin your document, you can cut and

paste or drag and drop.




Copy and Paste text

Select the text you want to copy.

B HIDISignature Wash

Cars 520 - SUVs 825 and up

Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs.
Interior vacuum, dust, and deodorize, plus windows inside & out.

B signature Interior
Cars 540 - SUVs 560 and up - March special! 55 off

Shampoo carpets, floor mats, seats, and door panels. Clean and protect console, dash,
and cup holders.

Click the Copy  command on the. Home.  tab.
lternatively, you can press Ctrl+C on your keyboard.
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Copy and Paste text

Place the insertion point where you want the text to
appear.

B H.0 Signature Wash

Cars 520 - SUVs 525 and up

Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs.
Interior vacuum, dust, and deodorize, plus windows inside & out.

Bsignature Interior
Cars 540 - SUVs 560 and up - March special! 55 off

Shampoo carpets, floor mats, seats, and door panels. Clean and protect console, dash, |
and cup holders.

Click ’rhe -P-asie commond on fh_é Home’rob AITerhoTiver,
you can press Ctrl+V on your keyboard.
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Copy and Paste text

The text will appear.

B H.0 Signature Wash

Cars 520 - SUVs 525 and up

Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs.
Interior vacuum, dust, and deodorize, plus windows inside & out.

- H,O[Signature Interior

Cars 540 - SUVs 560 and up - March special! 55 off

Shampoo carpets, floor mats, seats, and door panels. Clean and protect console, dash,
and cup holders.




Cut and Paste text

Select the text you want to cuf.

B HIDISignature Wash

Cars 520 - SUVs 825 and up

Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs.
Interior vacuum, dust, and deodorize, plus windows inside & out.

B signature Interior

Cars 540 - SUVs 560 and up - March special! 55 off

Shampoo carpets, floor mats, seats, and door panels. Clean and protect console, dash,
and cup holders.

Click the Cut command on the Home tab. Alternatively,
you can press Ctrl+X on your keyboard.
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Cut and Paste text

. Place the insertion point where you want the text to
appear.

B H.0 signature wash

Cars 520 - SUVs 525 and up

Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs.
Interior vacuum, dust, and deodorize, plus windows inside & out.

I
h H,O Signature Interior
Cars 540 - SUVs 560 and up - March special! S5 off

Shampoo carpets, floor mats, seats, and door panels. Clean and protect console, dash,
and cup holders.

lLeather Cleaning & Conditioning
Cars 520 - SUVs 540 and up - March special! 55 off
Includes seats and door panels.

. CJick the Paste command on the Home tab. Alternatively,
you can press Ctrl+V on your keyboard.
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Cut and Paste text

The text will appear.

- H,0 Signature Wash

Cars 520 - SUVs 525 and up

Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs.
Interior vacuum, dust, and deodorize, plus windows inside & out.

- H,0 Signature Detail
Cars $60 - SUVs §75 and up - March special! $10 off
Everything included in the Signature Wash, plus hand wax and buff. |

B H,0 signature Interior

Cars 540 - SUVs 560 and up - March special! 55 off

Shampoo carpets, floor mats, seats, and door panels. Clean and protect console, dash,
and cup holders.

YQu can also cut, copy, and paste by right-clicking your document and
hoosing the desired action from the drop-down menu. When you use
s method to paste, you can choose from three options that determine
how the text will be formatted: Keep Source Formatting, Merge
rmatting, and Keep Text Only. You can hover the mouse over each
icon to see what it will look like before you select it.




Drag and Drop text

Select the text you want to move.

B Paint Correction & Protection
Call for pricing - March speciall 10% off

Prices may vary depending on size of vehicle. Heavily soiled vehicles are subject to an additional charge. |
Schedule your appointment today!

Contact Hank Odum at 321-555-5400 or hank@H20mohile.com
Special rates available for weekly/monthly customers

H20 Mobile Wash & Valet | Just leave the details to us

Clickand drag the text to the location where you want it to

appear. A small rectangle will appear below the arrow to
inglicate that you are moving text.

B Paint Correction & Protection
Call for pricing - March special! 10% off

Prices may vary depending on size of vehicle. Heavily soiled vehicles are subject to an additional charge.
Schedule your appointment today!

Contact Hank Odum at 321-555-5400 or hank@H20mobile.com
Special rates available for weekly/monthly customers

H,O Mobile Wash & Valet | Just leave the details to us

L




Drag and Drop text

Release the mouse, and the text will appear.

B Paint Correction & Protection
Call for pricing - March speciall 10% off

Schedule your appointment today!
Contact Hank Odum at 321-555-5400 or hank@H20mobile.com

Special rates available for weekly/monthly customers

H.O Mobile Wash & Valet | Just leave the details to us

%Pn'ces may vary depending on size of vehicle. Heavily soiled vehicles are subject to an additional charge.

If text does not appear in the exact location you want, you
can press the Enter key on your keyboard to move the text to
a new line.




Undo and Redo

Let's say you're working on a document and accidentally delete
some text. Forfunately, you won't have to retype everything you
just deleted! Word allows you to undo your most recent action
when you make a mistake like this.

» To do this, locate and select the Undo
command s on:the - IQUIck e cess | — |

Toolbar,/ Alternatively, you can press 5 © Calibri Body) < |14 ~| A
Cirl+Z/on your keyboard. You can s o = 81 U-mx x
coniiue using this command to undo

mulfiple changes in a row.
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By contrast, the Redo command allows
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: " wedo Typing (Crl+Y
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Symbols

If you need to insert an unusual character that's not
on your keyboard, such as a copyright (©) or
trademark (™) symbol, you can usudlly find them with
the Symbol command.




Inserting a symbol

I. Place the insertion point where you want the symbol to
appear.

Schedule your appointment today!
Contact Hank Odum at 321-555-5400 or hank@H20mobile.com
Special rates available for weekly/monthly customers

H,0 Mobile Wash & Valet | Just leave the details to us|]

Prices may vary depending on size of vehicle. Heavily soiled vehicles are subject to an additional charge. |

Click the Insert tab.
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T - Pictures = a4 ocreenshot -

Tables

Illustrations




Inserting a symbol

locate and select the Symbol
command, then choose the desired

El - Q“' TT Equation -
symbol from the drop-down menu. If you 15 S
1 ext |
don't see the one you want, select More e ="To + ¢ ¢ ¥
Text B
Symbols. SRR AR

ore Symbols...

The/symbol will appear in the document.

Schedule your appointment today!
Contact Hank Odum at 321-555-5400 or hank@H20mobile.com
Special rates available for weekly/monthly customers

H,0 Mobile Wash & Valet | Just leave the details to us™| I

Prices may vary depending on size of vehicle. Heavily soiled vehicles are subject to an additional charge.




Practice

Open our practice document.

Scroll to page 2.

Place the insertion point at the top of the document
and type Now Introducing...

» Use your arrow keys to move the inserfion point to
the Signature Detail Plan's price and change it fo
$99.99/mo.

At/the bottom of the document, use drag and drop
tgd move Just leave the details to us to the end of the
st line.

I the end of the line you just moved, insert the
ademark symbol. If you cannot find the trademark
bol, insert a different symbol of your choice.



Solution

Now Introducing... Mobile

Wash & Valet

H,O Mobile’s

UNLIMITED WASH CLUB

H,O Signature Detail Plan $99.99/mo

Includes:

Fragrance

Hand wax

Wax and buff

Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs
Interior vacuum

Dust

Deodorize

Windows Inside & Out

H,O Signature Wash Plan $79.99/mo

Hand wash and dry vehicle, including tires, rims, wheel wells, and door jambs
Interior vacuum

Dust

Deodorize

Windows Inside & Out

For more details, contact Hank Odum at 321-555-5400 or hank@H20Omobile.com

Prices may vary depending on size of vehicle. Heavily soiled vehicles are subject to an additional charge.

H,O Mobile Wash & Valet | Just leave the details to us™




TAE END




